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Welcome to Easy 
Markdown
Easy Markdown is a markdown editor to create html web pages editing just plain 
text coded using the well known markdown language syntax, and obtaining web 
pages coded in html.

The Markdown language  specifies a set of rules and text formatting syntax  that 
translates a plain text in a correspondent formatted html code ready to be visualized 
on the web.

Using markdown you can edit a text and obtain, at the same time a correspondent 
web page (using the Markdown transformation from text to web) .

In that way you have a content that looks great both in text and inside the web 
because markdown doesn’t use special code tag such as in html to format your 
content

Markdown language is smart enough to understand how to format your web page 
starting from a simple text created with simply rules and using simple text marks 
commonly used in text.

Writing a manual about the Markdown syntax is out of the scope of this user 
guide.
On the web you can find a lot of information and documents about the 
Markdown language syntax.

The resulting web page is visualized live, as-you-type using an engine that working 
in background, transforms your text in a web page using the Markdown rules and 
syntax.
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At any time you can visualize the resulting web page using one of the provided CSS 
style sheet or using your own you edited and modified.
 
You can even build a library of CSS (custom style sheet) adapted to your use and 
change from them the active one, as you need, while you type.

As you type inside the editor, you see on the right, the web page growing live as you 
enter your input

At any time you can show and copy the html generated code ready to be pasted 
elsewhere.
You can also copy the webpage in rtf format.

You can also use an internal snippets library to paste pre-made text . The snippets 
library is available to all your documents.

Easy Markdown provides a series of features helping you create correct text pages 
that look correctly visualized both as text and as web pages.

What is important to understand is that Markdown as a language syntax is made not 
only to have simple text that automatically generates nice web pages , but to have a 
text that looks nice BOTH  as text and as web page.
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Getting Started with 
Easy Markdown
Launch the app

Create a new document if not created by the app. In the left part of the window you 
can immediately start typing text.

On the right of the window the content on the left is immediately converted in web 
content
There is no a ‘update’ or ‘render’ button.
At any single keystroke the web view on the right is updated to match the text on the 
left

Easy Markdown presents on the left a full featured editor with line numbers
The line number ruler shows the effective rows, as they are considered if separated 
by newlines or returns.
The wrap of a line to fit it inside the editor it is not considered a newline by the editor 
and by the Markdown code generator

Easy Markdown visualize on the right of the window the web view using a custom 
style sheet you can change from a popup at any time

You can change the style sheet in use and in case you are testing and editing the 
style sheet using an external editor, you can reload the page using the updated style 
sheet with a single keystroke
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Markdown is also useful to generate small pieces of html code to paste in other app 
or on the web.
Easy markdown allows to write the text on the left and instantly press a button to get 
the correspondent html code 

At any time you can copy with a single command the markdown code, the html code 
and also the web page copied in RTF.

The copied content will be ready to be used in any other app.

You can also visualize and inspect the generated html code while you are typing 
inside the markdown code editor. 

The content on the right updates at any single keystroke or modification you made, 
live and without any delay.

Easy Markdown offers also a lot of functionalities that help you in the work of 
creating markdown code that translates in beautiful html content and is nice also 
when displayed as text (This is a ‘markdown language’ feature).

In the toolbar Easy Markdown has many tools that are context sensitive
They change in accordance of the row the cursor is in.

As example, considering many markdown marks are used at the start of the row 
only, Easy Markdown is smart enough to recognize which mark is applied at the 
start of the current row and allow you, with a simple click, to add, change or remove 
the tag at the start of the current row.

Other tags can be inserted at the cursor selection, such as html links and images, 
using the toolbar commands.
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Reference

The app

Easy Markdown is a markdown viewer and editor
it’s a document based application and the content of the window can be saved on 
disk.
Easy Markdown allows to edit text content and immediately see the text represented  
as web content using the Markdown specifications to transform the edited content in 
html code

The translation is performed in background while you type and the result is 
visualized as you type without any delay. You immediately see the result without 
issuing any command.

The html code can also  be seen as-you-type.

The window

The Easy markdown window is divided in 2 parts by a vertical split:

• The Editor on the left
• The Web viewer on the right

The Web view can be visible or collapsed showing only the editor
The web view is visible by default.
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As soon as you type in the editor on the left you see the right part is upgraded with 
the web content without any delay.

The right part can be subdivided in another two parts by an horizontal split:

• The Web view
• The Html view

The Html view can be visible or collapsed, showing only the web view.
The html view is collapsed (invisible) by default.

The Editor

The editor is the part where you insert your input
It is a standard macOS editor plus some additional features.
A ruler showing the row number on the left. The row number is referred to the 
unwrapped rows. A row is considered only when terminated by a newline or return 
(except the last one)
This is the reason the line number representation may change when you change the 
width of the editor area and the text is wrapped to adjust to the new text width.

In the toolbar there are some commands available to format the text to apply some 
Markdown marks.

The largest row of buttons allow to apply marks that are effective only if applied at 
the start of the row
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This row of buttons is smart enough to adjust itself to the tag already applied to the 
current row.
If another tag is selected the tag at the start of the row is automatically changed.
It changes even if you change the mark by hand.

Another series of command under the {M} popup  allow to apply marks that are 
related to the selection or position of the cursor inside the editor

The {M} menu at the bottom replicates the command of the toolbar

In the bottom part of the editor area two buttons allow to change the size of the used 
font.

The TEXT button allows to copy in the clipboard the full content of the editor

The {M} button to paste common markup 
They are the same available from the toolbars using the {M} popup

The {S} button to paste pre-made snippets (portion of text of common use you can 
prepare by yourself)
They are the same available from the toolbars using the {S} popup
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The Web View

In the right part of the window, the app displays the web view.
The web view reflects the code inserted on the left, processed through the 
markdown rules to transform it in html code and visualized inside a web view.

All this happens as-you-type, with zero delay.

The web view can be collapsed manually dragging the vertical split.
The view can be collapsed and expanded using also the ‘Web View’ icon in the 
toolbar or via the menu or using the related command key.

In the bottom part of the web view some icons allow to use larger and smaller fonts 
and to copy the RTF obtained from the view.

The view uses always a custom style sheet to visualize the web page.

This style sheet can be changed at any time by the user via a popup button in the 
lower right part of the Web View.
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The popup shows all the available style sheet.
The style sheet in use can be reloaded (useful if you modify it with an external 
editor).

Selecting a style sheet immediately applies the selected style to the page.

The style sheet in use can also be visualized in the finder using the magnifier glass 
button.

The user can manage all the style sheets available to the app from the preferences
The user can add and modify style sheets as preferred via preferences

Easy Markdown User Guide  © 2012-2025 Ecleti - Roberto Panetta page 10



The pen button can open the preferences already on the CSS (Cascade Style 
Sheet) tab to operate on style sheet

The Html View

The View on the right can be further split in two parts with an horizontal split:
The Web view
and the Html view

The Html View can be expanded (it is collapsed by default) in the lower part of the 
Web View via an horizontal split.

The Html View shows the html code as-you-type inside the editor.
It simply shows the html code sent to the web view.

The Html view can be visualized from the toolbar, or the menu or using the 
corespondent command key.

The Html View, as the other views, allows to change the size of the font and shows 
the total chars generated inside the html view.

Via the Html View you can see the true html used in the body of the web view.

Pressing the ‘HTML’ button the html code can be copied in the clipboard ready to be 
used in other apps.

The html view can be adjusted to show just the html body of the text or the full html 
page or the page with embedded inside the head part the used style sheet
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At any time you can decide to copy one of the 3 using the popup menu on the 
bottom left part of the HTML view

You can also save on disk as text or html file.

Changing and editing the style sheet
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If you need to use a custom style sheet you need to load it from the preferences. 
They will be available in all the documents inside  the popup menu at the bottom of 
the Web View.

If you need to edit a style sheet yo can do it with an external editor. 
After saving it, if it is the active style sheet in use in the view, you can reload it using 
the ‘Reload’ command from the View menu.
The web page will refresh reloading the style sheet from disk.

Fonts

You can apply different font styles to the editor and the Html view
From the ‘Edit’ menu select ‘Fonts…’
The standard font selection dialog will open
Clicking in the ‘Code View’ you can apply the font you like to the editor
Clicking the ‘Html View’ you can apply to it the font you like.
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The text documents managed by Easy Markdown are pure text files and can’t retain 
the information of the used fonts, so every time you will close and file you will lose 
the selected fonts.

To help you to have a font different form the default one ‘Menlo Regular’ you can 
select a font in the Preferences in the ‘Advanced’ tab.
These fonts will be used for any newly opened file.

Apply row tags

In markdown languages tag at the start of the row has particular meaning
Easy Markdown provides a special way to manage them
You can select one ore more row and select which tag you need at the end of the 
line using the ‘Start Row’ tool in the toolbar.

Easy markdown will put that tag at the start of any line selected in a single click
In case a different tag were applied, it will be changed to the new one

When you select a group of rows and all the rows has the same tag applied, the 
palette in the toolbar will show it.

The same is valid for the double space you can apply at the end of any line to force 
a newline in the resulting html
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You can select one or more row and force the double space at the end of any 
selected line, all in one click via the toolbar using the ‘End Row’ tool.

The ‘End Row’ toll will also show when a group of selected lines has the same tag 
ant row end.

Markdown Extensions

Easy markdown uses some extension to the classic Markdown language:

Tables
Fenced code
Footnotes
Autolink
Strikethrough
Underline
Highlight
Quote
Superscript
Math

Snippets

Snippets are small portion of text ready to be pasted in the editor

You can prepare text portion in the editor  and copy snippets inside the Snippet 
Manager.

After saved inside the Snippet Manager, code is reusable selecting it from the {S} 
popup menu available in any document both in the toolbar and at the bottom of the 
code editor.
Selecting it will paste it at the current cursor point

You can access the Snippet manager from the toolbar or the menu.
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Add a new snippet to the manager pressing the ‘+’ button then paste the code in the 
content area on the right.
Then double click the snippet name on the left and edit the name you like.

Snippet will be available in any opened document under the snippets popup.

Selecting a snippets from the snippets popup, will immediately paste it inside the 
editor of the active document.

Print

You can print any of the 3 views: the editor, the web view and the html view.
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Click them to make one the printable view, then select ‘Print’ from the file menu.

Dark and Light Appearance Mode

This application is also fully compatible with Dark and light Appearance Mode 
available on macOS from macOS 10.14 Mojave and successive.
You can switch at any time from one mode to another.

Preferences

General

Specify the action to do at startup:

• Standard Behavior
• Open Dialog if No resume
• Open Dialog Always
• Open Selected document
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To select a document press the select from disk button and select it from the open 
dialog that will follow

At any successive relaunch Easy Markdown will execute the option selected.
The additional 3 buttons at the foot of the edit field let you:
• Show in the finder the selected file
• Test open the selected file as it will be done at the next application launch
• Delete the bookmark reference to the file (you will need to reselect a file)

The reference to the file is taken using scooped bookmarks and they work even if 
you move the file on your disk, even if your file is in the trash.
To update the path display in case the file was moved,  click the ‘show in finder’ or 
the ‘test open’ button

Style Sheet

The Style Sheet section allows to select the style sheets available to be used by the 
web view.
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You can add , remove and view in the finder the listed style sheets using the buttons 
at the bottom of the list.
To add a Style Sheet select the '+' button and select it from disk.

At our web site you can download from the download section a collection of freely 
distributable style sheets you can use inside Easy markdown
You can add all them in a single operation selecting all them after pressing '+' in a 
single operation
You can also create your own Style Sheets and use them inside Easy Markdown

Advanced

The advanced section allows to specify some initial states for the document
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Show the Html View at startup
The initial size and font for the 3 views.
These settings will be applied to any newly opened documents because markdown 
files can’t retain font informations because they are just simple text files. 

Sandbox

Easy Markdown is a sandboxed app.
As you may know any new application on the App Store is now sandbox enabled.
(New application not sandboxed are not admitted inside the App Store)
Sandbox technology introduces a new level of security on your Mac.
As example any operation of files inside the user folder need to be authorized by the 
user
Easy Markdown is allowed to access files previously authorized by the user using a 
technology called ‘Scooped bookmarks’.

Resume

Easy Markdown will reopen documents the user left opened included unsaved one.

Auto Save

Easy Markdown saves using the Autosave functionality available in macOS

Versions
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The user can look at previous versions of documents and restore to any earlier 
version (just select Revert to Saved from the menu or the down arrow at the right of 
the title window, it appears only if you move the cursor over)

Full Screen

The user can switch at any time to full screen  using the native OS X full screen 
mode and commands (use the upper right icon in the window to go full screen and 
bang the mouse in the upper part of the screen to re-obtain the menu and eventually 
clicking the standard icon to exit the full screen mode)

User Guide

Available under the Help menu also a PDF user guide. 

Support
 
You can also obtain support using the ‘Email Support’ command. An email will be 
prepared using your email client with the correct address to send to.
Yes, we answer to your emails!
Please specify the name of app you are writing about.
We have many apps in the app store.

User Review
 
If you like this app, please find a minute to write a review inside the App Store.
Use the  ‘Write an App Store Review’ command under the Help menu to do it.
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It will help us selling other copies of Easy Markdown  and continue the development 
work.
From our experience, unfortunately, often satisfied users stay silent.
Don’t do that. Just write few words but write them. You will help us a lot.
Thank you in advance to writing a review.

Other Software We Make
 
Yes. We have more than one app in the App Store. Please have a look using, from 
the help menu the ‘Show App Store List’ command. 
Maybe we have some other app that you can like!
Thank you for your support.

About Tension Software and Ecleti

All the software asset by Tension Software is now under Ecleti 
New company name but still the same owner and main developer (Roberto Panetta)
So for the users nothing changes. We provide the same software and the services. 
All the user licenses are valid and assistance is provided as before to all our users.
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